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1 Welcome to GUITAR RIG
 

Thank you for purchasing GUITAR RIG. We hope you enjoy using this product as much as
we did creating it!
This Getting Started guide provides you with the essential information needed to use GUI­
TAR RIG and explains how to accomplish fundamental tasks.
The following documents are also available:

▪ The Setup Guide tells you how to install, activate and configure GUITAR RIG on your
system.

▪ If you want to dig deeper into GUITAR RIG and its possibilities, check out the GUI
TAR RIG Application Reference. It explains every function of the platform in greater 
detail.

▪ To learn about each and every parameter that controls the amps, distortion pedals 
and other components for shaping and modulating GUITAR RIG'S sounds, refer to the
Components Reference.

▪ If you have obtained GUITAR RIG in a hardware bundle (Mobile/Session/Kontrol),         
please read the according Hardware Reference to correctly set up your hardware and 
software.

All manuals can be accessed through the program menu by selecting Help > Open Man­
ual.
You can also visit the community forums at http://www.native-instruments.com/forum 
where beginners and experienced users exchange knowledge on Native Instruments prod­
ucts every day.
But now let's get going…

1.1 What is GUITAR RIG?
 

GUITAR RIG is really powerful piece of software that can be used for creating guitar and
bass tones, as well as complex effect chains for virtually any musical purpose.
It is like a room filled with legendary amplifiers, endless arrays of cabinets, each with dif­
ferent microphones, any effect you desire, a loop machine and other amazing tools for 
crafting sounds at your immediate disposal.

Welcome to GUITAR RIG
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GUITAR RIG comes in four different editions: Factory Selection, LE, Essential and Pro—
differing in the number of included components. But no matter which version of GUI­
TAR RIG you have, you can easily load it up using Powered by GUITAR RIG products, ex
panding the selection of components for guitarists, producers and DJ’s too. Additional 
GUITAR RIG products will be released regularly in future. Please check the Native Instru
ments website for the latest products.

1.2 What’s New in GUITAR RIG 4.1?
 

GUITAR RIG 4.1 implements many improvements to the software. Here’s what’s new in    
comparison to older versions:

▪ GUITAR RIG 4.1 is a new extendable platform for guitar and producer effects. All ver­
sions of GUITAR RIG are now extendable using KOMPLETE Effects powered by GUI
TAR RIG products. These additional products offer a multitude of new components 
and effects, and can be purchased directly from the NATIVE INSTRUMENTS website.

▪ GUITAR RIG FACTORY SELECTION is a new free version of GUITAR RIG with a basic
set of components. GUITAR RIG FACTORY SELECTION can also be updated with ad
ditional KOMPLETE Effects powered by GUITAR RIG products of your choice.

▪ A redesigned Components Pool offering improved possibilities to find effects not only 
by category but also by the KOMPLETE Effects powered by GUITAR RIG product to
which they belong.

▪ The Preset Volume Rack Tool has been updated with additional controls for the Dry, 
Wet and Mix Levels that can be stored on preset basis.

▪ GUITAR RIG 4.1 now provides support for MAC 64-bit.

1.3 System Requirements
 

In order to run GUITAR RIG 4.1 without problems, your computer and operating system 
should at least fulfill the minimum specifications listed below.

1.3.1 PC Requirements
 

Hardware: Pentium® or Athlon XP 1.4 GHz, or higher with at least 1 GB RAM
Operating system: Windows® XP (SP2, 32bit) / Vista® (32/64 Bit), Windows 7® (32/64 
Bit)

Welcome to GUITAR RIG
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Hard disk space: 1 GB
Audio Hardware (for standalone operation): Any Fully compliant ASIO™ (recommended), 
DirectSound™, WASAPI interface™
Supported Drivers: VST®, RTAS® (Pro Tools 7/8)

1.3.2 Mac OS X Requirements
 

Hardware: Intel® Core™ Duo 1.66 GHz or higher with at least 1 GB RAM
Operating system: Mac OS® X 10.5 or higher
Hard disk space: 1 GB
Audio Hardware (for standalone operation): Any fully compliant Core Audio™ interface
Supported Drivers: VST®, Audio Units™, RTAS® (Pro Tools® 7/8)

1.4 KOMPLETE Effects Powered by GUITAR RIG
 

KOMPLETE Effects powered by GUITAR RIG can be used with all editions of GUITAR RIG,
including the free FACTORY SELECTION edition. These products must be actived via the
Service Center before use. After activation, new components can be found in the Compo­
nent Pool under the according product library tab and the relevant component category.

If you have purchased a KOMPLETE Effects powered by GUITAR RIG product, please activate
GUITAR RIG FACTORY SELECTION before use, unless a higher edition of GUITAR RIG is al
ready activated on your computer.

For detailed information on KOMPLETE Effects powered by GUITAR RIG components please
refer to the product documentation.

1.5 Safety Considerations
 

GUITAR RIG, in combination with headphones or amplifier-driven speakers, can produce
volumes that may cause hearing damage. For your protection, set all volume levels to a 
minimum before using GUITAR RIG. Gradually raise the volume controls while music is   
playing to set the desired listening level. If you experience any hearing problems or persis­
tent ringing in the ears, consult an audiologist immediately. For information on how to set 
the correct volume, please read section ↑4.1.1, Playing the Loaded Preset.

Welcome to GUITAR RIG
KOMPLETE Effects Powered by GUITAR RIG
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2 Setup
 

This chapter will shed light on some fundamental aspects of setting up GUITAR RIG for
performance and music production.
Once the installation and activation process is complete, you will find the GUITAR RIG di
rectory on your hard drive. It contains the GUITAR RIG application and the documentation
resources.

If you want to know in greater detail what GUITAR RIG has to offer or if you need assistance
in understanding a particular feature, please read the Application Reference.

2.1 Activating GUITAR RIG
 

In order to use GUITAR RIG software without limitations, you need to activate it. When you
start GUITAR RIG for the first time, a splash screen will open and provide you with a con
venient way to start the Activation procedure: Click the Activate button on the splash 
screen. This will launch the separate NI Service Center application. During the Activation 
procedure, the NI Service Center will ask you to enter your GUITAR RIG serial number. If
you have downloaded GUITAR RIG from the NATIVE INSTRUMENTS website or bought a
KOMPLETE Effects powered by GUITAR RIG product, you should have received this serial
number. If you have bought a product that includes GUITAR RIG, the serial number            
should be printed on a registration card. If you do not have a serial number for GUI­
TAR RIG already, you can request one from the NATIVE INSTRUMENTS website.

For detailed information about Activation please read the Service Center’s Setup Guide, which
is installed with Service Center.

2.2 Quick Overview
 

2.2.1 Operation Modes
 

Before you start GUITAR RIG for the first time, it’s worth explaining that there are two ba
sic modes of operation:

Setup
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▪ In Stand-alone mode GUITAR RIG will work independently of any other software.
▪ In Plug-in mode GUITAR RIG will run as plug-in of a host application.

Start the application in Stand-alone mode by double-clicking the "Guitar Rig 4" shortcut 
on your Desktop. Alternatively, you can double-click the program file in the Installation 
folder.

2.2.2 Viewing Modes
 

In both Stand-alone and Plug-in modes GUITAR RIG can be used in two different stream
lined viewing modes:

▪ Standard view: In Standard view, GUITAR RIG is a laboratory giving you all the options
to build and organize your presets. Stack up and combine the countless effect units, 
prepare live gigs, record tracks or experiment with effect chains to shape unheard 
sounds.

▪ Live view: In Live view, GUITAR RIG hides all the sound creation tools, but puts the
most important performance features into a clear layout—perfect for on-stage use.

▪ Click the LIVE button on the Global Header, or hit F1 to switch between the Live view 
and the Standard view. Please take some time to familiarize yourself with the two dif­
ferent views.

Setup
Quick Overview

 

GUITAR RIG - Getting Started - 10



Standard View

Fig. 2‑1 GUITAR RIG in Standard view

In Standard view, GUITAR RIG is made up of five main areas: The Global Header [1] as­
sembles the main input and output controls, as well as the system performance. The Side­
Kick [2] displays different content, depending on which of the tab buttons (Browser, Com­
ponents or Options) is activated. The Toolbar [3] provides access to all Rack Tools and 
other frequently used features. The Rack [4] holds all components that are processing your 
sound—giving a clear overview of the signal flow. Virtual Rig Kontrol [5] is a graphical rep­
resentation of the RIG KONTROL foot controller, indicating which functions are assigned
to its buttons and the foot pedal.
 
 
 
 

Setup
Quick Overview
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Live View

Fig. 2‑2 Guitar Rig in Live view

In Live view, GUITAR RIG is made up of five main areas: The Global Header [1] assembles 
the main input and output controls, as well as the system performance. The Preset List [2] 
as defined in the Preset Browser. A Large Virtual Rig Kontrol [3] with all assignments from 
the Preset. The name of the selected Preset [4] with information. The Metronome, Tuner, 
and Loop Machine (optional) [5].

Setup
Quick Overview
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3 Using GUITAR RIG (Operation Modes)
 

The following subchapters provide information on using GUITAR RIG as a Stand-alone ap­
plication, as well as on running it as a Plug-in in a host application.

3.1 Using GUITAR RIG as a Stand-alone Application
 

As a Stand-alone application, GUITAR RIG turns your computer into a ready to use guitar
rack all by itself—change components, build presets, practice to backing tracks, record 
ideas or play gigs without needing anything else.
When you launch the stand-alone version of GUITAR RIG for the first time, you need to     
select an audio device and enable all MIDI devices you want to use.

The settings described in this chapter only apply to the stand-alone version of GUITAR RIG.
When GUITAR RIG is running as a plug-in, the host software handles all audio and MIDI input
and output. Please refer to the documentation of your host software for audio and MIDI con­
figuration details.

3.1.1 Audio and Midi Settings
 

In order to listen to the sound GUITAR RIG generates, you need to configure your audio
hardware device (i.e., your soundcard or external audio interface) for use with GUI­
TAR RIG.

Use Low-Latency Drivers
Whenever possible you should use low-latency drivers while working with GUITAR RIG.          
GUITAR RIG works with two types of low-latency drivers:

▪ ASIO™
▪ Core Audio™ (only on computers running Mac OS® X)

These technologies have been developed to ensure an efficient data transfer between soft­
ware and audio hardware and should provide a latency that is suitable for live play, if not 
unnoticeable.

Native Instruments recommend you always use the latest drivers for your audio hardware.           
Please refer to the manufacturer for more details.

Using GUITAR RIG (Operation Modes)
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Configuring Audio and MIDI Settings
When you launch the stand-alone version of GUITAR RIG for the first time, the Audio and
MIDI Settings dialog should open automatically.
To select or change your audio device at a later stage:
1. Open the File menu (on Windows XP/Vista) or respectively the Guitar Rig 4.1 menu 

(on Mac OS X).
2. Go to Audio and MIDI Settings… (on Windows XP/Vista) or Preferences… 

(on Mac OS X).
3. Select your audio device and driver from the relevant drop-down menus.
4. Click OK to confirm.

3.1.2 Selecting a MIDI Control Device
 

If your MIDI device has knobs, faders or other control sources, you can use those to con­
trol individual component parameters. GUITAR RIG will automatically detect a MIDI de
vice and receive control messages from it.
The MIDI tab of the Audio and MIDI Settings dialog provides a list of all MIDI inputs and 
outputs that have been found on your system. These are ports of physical MIDI interfaces 
connected to your computer, but also any virtual MIDI ports that may be provided by driv­
ers or other applications to facilitate inter-application MIDI usage.
To select or change your MIDI control device:
1. Open the File menu (on Windows XP/Vista) or respectively the Guitar Rig 4 menu 

(on Mac OS X).
2. Go to Audio and MIDI Settings… (on Windows XP/Vista) or Preferences… 

(on Mac OS X).
3. Select the MIDI tab.
4. Select the In tab.
5. Select On in the Status of the MIDI control device you want to use.
6. Click Ok to confirm.

3.1.3 Latency Optimization
 

Real-time audio processing—like recording a guitar with GUITAR RIG live into your com
puter—requires an audio device to convert the analog signal into digital data in a very 
short time. On-board audio devices of some computers are not always suitable for the task, 

Using GUITAR RIG (Operation Modes)
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because their drivers are not optimized for fast signal processing. The result is an audible 
delay from the moment you play a note on your instrument until you hear the output from 
your speakers. This delay is measured in milliseconds and called latency.
Large amounts of latency can be difficult to work with. By adjusting the output latency of 
your audio hardware you can control how quickly the audio signal generated by GUITAR 
RIG becomes audible after you have played your instrument. The minimum amount of la­
tency that can be achieved without inducing crackles and other noises depends on how 
much CPU power is available to audio processing. On a modern computer that has been 
set up correctly, there should be no perceptible delay. Older computers may require a 
more relaxed latency setting. The way the latency is adjusted from within GUITAR RIG dif
fers depending on the operating system you are using.

Windows®
1. Click the ASIO Config button in the Audio and MIDI Settings… dialog to open your audio 

hardware's control panel.

Using GUITAR RIG (Operation Modes)
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2. In the control panel belonging to your audio hardware, select an output latency of 
about 10 ms or 192 samples. This should work well on most computer systems.

Using GUITAR RIG (Operation Modes)
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3. To confirm the settings you have made, click OK.

Mac OS® X
1. Move the Latency slider at the bottom of the Audio and MIDI Settings… dialog and start with 

a value of about 192 samples.

Using GUITAR RIG (Operation Modes)
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2. To confirm the settings you have made, click OK.

When adjusting the output latency settings for both PC and Mac, a minimum audio buffer size 
will achieve lower latency, but is dependant on CPU power and the quality of the audio driver 
you have installed. An audio buffer size that is too low may tax your CPU and provide undesir­
able audible results. Some trial and error may be required before the right value is found for 
your computer. Please adjust the output latency accordingly.

3.2 Using GUITAR RIG as a Plug-in
 

The plug-in version of GUITAR RIG allows you to use it as a virtual instrument inside your
DAW (Digital Audio Workstation) such as GarageBand, Cubase, Logic, Pro Tools, Live, and 
Sonar etc. It can work as an insert and as an FX plug-in. As a plug-in, you can run multi­
ple instances of GUITAR RIG side-by-side along with your other sound generators and ef

Using GUITAR RIG (Operation Modes)
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fect plug-ins, trigger them with the data of MIDI tracks from within your DAW, and directly 
feed their audio output into the signal flow of your virtual mixer. Depending on your oper­
ating system and choices upon installation, GUITAR RIG provides VST, Audio Units, and
RTAS® plug-in formats. Refer to the documentation of your DAW to find out which of 
these formats is the right one in your case.

When GUITAR RIG is running as a plug-in, the host software handles all audio and MIDI input
and output. Please refer to the documentation of your host software for audio and MIDI con­
figuration details.

Using GUITAR RIG (Operation Modes)
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4 Tutorial
 

In this chapter, you'll find tutorials on working with presets, Components, and building a 
Rack.

4.1 Working with Rack Presets
 

The left-hand side of GUITAR RIG is dedicated to the Browser. This is your main environ­
ment for finding sounds, as it displays all GUITAR RIG presets and components installed
on your system.

Fig. 4‑1 Finding and loading Rack presets

Tutorial
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The top left side of the Browser [1] shows the available Attributes, while the bottom left-
hand side of GUITAR RIG holds the Search Results List [2]. The Search Results list is au­
tomatically updated to display only those presets that match all selected Attributes. In or­
der to find a sound you have in mind, click all Attributes that describe this sound. Alterna­
tively, enter the name or characteristic of a preset into the search engine to quickly find 
what you are looking for. The Search Results List will become shorter as you refine your 
search criteria.

▪ To load a Rack Preset from the Search Results List, simply double-click on the name 
of the Preset.

Tutorial
Working with Rack Presets
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4.1.1 Playing the Loaded Preset
 

Fig. 4‑2 Setting the Input and Output Meter

Setting the Correct Volume
After loading a Rack Preset, you are almost ready to play your Instrument but first, for your 
protection, set all volume fader levels to a minimum. Gradually raise the Input Meter IN 
[1]. This shows the amplitude of the incoming signal and features an integrated volume 
fader that controls the input level. It should be adjusted so that the Input Meter gets close 
to, but never hits the red zone, which is indicating overload. If no sound is audible, watch 

Tutorial
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the Output Meter OUT [3]. This shows the amplitude of the software’s output and features 
an integrated volume fader that controls the output level. It should be adjusted so that the 
limiter is never triggered, indicated by the Ouput Meter hitting the orange zone.
If the Output Meter does not show any activity, you might need to check GUITAR RIG’S
Audio and MIDI Settings (if you are using GUITAR RIG as a stand-alone application) or  
your host software’s Audio setup (if you are using GUITAR RIG as a plug-in).
The Gate button [2] operates a basic noise Gate, killing hiss when you are not playing. Turn 
it on and off by clicking on the button, adjust the threshold to your actual residual noise 
level with the knob right of it. When double-clicking the threshold knob, a learn function 
to automatically set the optimum threshold is it activated. Do not play your instrument for 
some seconds: GUITAR RIG analyzes your signal and sets the threshold just above any re
sidual noise.
You are now ready to use GUITAR RIG! Please try out different presets and familiarize 
yourself with different components. When you are feeling confident try tweaking the pre­
sets to find the exact sound you require.

As you play it is good practice to tune your guitar, especially if you are going to record. GUI­
TAR RIG comes with is own comprehensive built-in Tuner. Please refer to the Tuner chapter
for more information.

4.1.2 Tweaking the Loaded Preset
 

All sound tweaking in GUITAR RIG is done in The Rack: Tweak the loaded Rack Preset by 
changing the individual parameters of components to suit your needs, or discover new 
sounds and combinations by changing components and building a completely new rack. 
Feel free to experiment, as any changes you make will not automatically be saved. If you 
like what you hear and want your changes to be permanent, click Save in the Toolbar.

Please refer to the Component Reference for a detailed guide to each components parameters.

Tutorial
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4.2 Changing Components
 

The audio signal runs through the chain of rack modules from top to bottom, except if you 
are using special tools that create parallel processing paths, like the Split. See the Compo­
nents Reference for details on these tools.

4.2.1 Drag and Drop
 

Fig. 4‑3 Drag components from the pool and drop them in the rack.

▪ You can add components to the Rack by dragging them from the Component Pool and 
dropping them into any position you want. The faint yellow line indicates where the 
component will be placed after releasing the mouse button.

Tutorial
Changing Components
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▪ Dropping a component from the pool directly on to a component in the rack will re­
place it.

▪ Rearranging rack modules works with drag and drop—just click on some empty area 
of the component and drag while holding the mouse-button. A faint orange line indi­
cates where the component will go when you drop it by releasing the mouse-button.

▪ You can also add a component pre-configured to produce a particular sound, by drag­
ging a Component Preset into the Rack.

▪ You can remove Components from the rack by highlighting them and pressing DEL 
(Win) / BACKSPACE (Mac), or by dragging and dropping them anywhere outside of 
the rack. Another option is to choose Delete selected from the context menu, after 
right-clicking the component.

▪ Rack Tools (Tuner etc.) have a fixed position and cannot be moved or deleted, but 
they can be hidden using the Toolbar.

4.2.2 Hot Swapping Components
 

Fig. 4‑4 Hot swapping Components

▪ When you click on the empty space of any rack module (not on any knob or switch), it 
is highlighted by an orange frame [1], meaning it is selected.

▪ Selected rack modules will be replaced if you double-click on an item in the Compo­
nent Pool [2]. If no rack module is highlighted, double-clicking will add the compo­
nent to the end of the rack.

4.2.3 The Rack Module Column
 

All modules in the rack feature a small column on the right:

Tutorial
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Fig. 4‑5 Rack Columnn

▪ The On/Off button [1] allows for true bypassing of the module—no CPU power is con­
sumed when it is turned off.

▪ The Minus button [2] minimizes the module’s display.
▪ The triangular arrow [3] toggles its expert panel, if available.

4.3 Building a Rack From Scratch
 

4.3.1 Overview
 

The first time you start GUITAR RIG, the Rack will be empty. You will hear a dry, ampli­
fied guitar sound when you play: perfect time to try out the various components. On future 
starts, the software will always retain the Rack's last state.

▪ Click on X in the Toolbar to empty the Rack.
▪ Click the the small Arrow button (next to the Preset name) in the Toolbar or Press F2 

to reveal the Sidekick. For an overview of the Toolbar see section ↑5.1.3, Toolbar and 
Rack.

Tutorial
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Fig. 4‑6 The Components Pool with an empty Rack

The Components Pool
▪ Open the Component Pool by clicking Components in the SideKick.

The Components Pool contains two more tabs. These tabs streamline components into two 
views:

▪ Categories
▪ Products

Tutorial
Building a Rack From Scratch
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Fig. 4‑7 The Components Pool available in the Sidekick

Components [1] displays the Components Pool. Categories [2] displays all component catego­
ries in alphabetical order. Products [3] provides access to all installed GUITAR RIG and 
KOMPLETE Effects powered by GUITAR RIG products. Category tabs [4] reveal/hide com­
ponents belonging to the chosen category. The scroll bar [5] allows you to scroll the list of 
categories. The component list [6] displays in alphabetical order, a list of installed compo­
nents based on each category. The Category Arrow Buttons [7] allow quick access to each 
category. The Component Preset List [8] displays all the presets for a selected component.

Tutorial
Building a Rack From Scratch
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Categories [2]
This view contains all components and their presets, ordered alphabetically into catego­
ries. Click a category label to reveal a list of installed components. The list of available 
components will vary with each edition of GUITAR RIG and if any KOMPLETE Effects pow
ered by GUITAR RIG products are installed.

▪ AMPLIFIERS: Guitar and bass amps
▪ CABINETS: Matched cabinets, Cabinets & Mics, and Control Room
▪ DELAY / ECHO: Delays and Echo units
▪ DISTORTION: Distortion, Overdrive and Fuzz pedals
▪ DYNAMICS: Compressors, Limiters and Gates
▪ EQUALIZER: Shelving, Parametric, Graphic, and Custom EQ
▪ FILTERS: Filters and wah-wah pedals
▪ MODIFIERS: Assignable modifiers for parameter modulation
▪ MODULATION: Time and pitch-based modulation effects
▪ PITCH: Pitched based effects and synthesizers
▪ REVERB: Various high quality Reverbs
▪ SPECIAL FX: Various specialist effects
▪ TOOLS: Loop Master FX and tools for parallel signal processing

When you select a component by clicking on it, it is highlighted, and a list of all available 
Component Presets is shown below. Learn more about Component Presets in section ↑5.4, 
Presets.

Products [3]
This view is streamlined to help you locate components on a product by product basis. The 
Products view contains an alphabetical list of all installed component products. This in­
cludes the component products installed with your edition of GUITAR RIG and any addi­
tional KOMPLETE Effects powered by GUITAR RIG you have purchased.

Category Arrow Buttons
Below the scroll bar in the Components Pool are two small arrow buttons to help you 
quickly navigate from one category to another. These buttons will eliminate the need for 
excessive scrolling and help you move between categories when building a rack or looking 
for a particular component.
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To view additional information on a particular component, please refer to the Component 
Reference.
To open the Component Reference from Guitar Rig:
1. Open the Help menu.
2. Go to Open Manual….
3. Select Component Reference from the drop-down menu.

4.3.2 Setting Up an Amp
 

A common start for designing sounds with GUITAR RIG is adding an amp to the Rack. If
you want to create a guitar sound, try the Jump amplifier:
1. Double-click on the Amplifier category in the Components Pool to reveal the list of 

amplfier components.
2. Double-click the Jump amplifier icon to quickly add it to the Rack.
The amp and a Matched Cabinet will simultaneously be added to the Rack. If you play 
now, you will hear the famous British amp sound (or rather a tastefully gain-spiced version 
of it).
All the knobs and switches you see are actually controlling the amp’s sound. Clicking with 
the mouse flips the switches, clicking and dragging the mouse up and down (while holding 
the mouse button down) turns the knobs. If you want to check out some amp settings pre­
pared by our sound designers, try component presets to configure Jump.
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Fig. 4‑8 Loading a Component Preset

▪ Click the triangular arrow of the Component Preset box [1] to reveal the component 
preset list.

▪ Click one of the Component Presets [2] listed in the drop-down menu, alternatively, 
load presets from the component pool’s integrated preset browser.

4.3.3 Basics of Rack-Building
 

Now you can tweak the amp yourself, add distortion modules, modulating effects or try out 
whatever you please. But before, there are a few more basic principles to know:

▪ The audio signal runs through the chain of rack modules from top to bottom, except if 
you are using special tools that create parallel processing paths (like the Split).

▪ You can add components to the Rack by dragging them from the Components Pool 
and dropping them into any position you want. You can also add the component pre-
configured to a particular sound by dragging a component preset into the Rack

Tutorial
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▪ Selected rack modules will be replaced if you double-click on another component in 
the Components Pool (or another component preset will be loaded, respectively). If no 
rack module is highlighted, double-clicking will add the component to the end of the 
rack.

▪ You can remove components from the rack by highlighting them and pressing DEL or 
by dragging and dropping them anywhere outside of the rack.
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5 User Interface Reference
 

Learn about the areas and elements of the user interface in this section.

5.1 User Interface (Overview)
 

Learn about the areas and elements of the user interface in this section.

5.1.1 Global Header
 

The Global Header holds the most important controls. It is always visible in GUITAR RIG.

Fig. 5‑1 Global Header

This element might not seem that interesting at first glance but understanding the Global 
Header is crucial for working with GUITAR RIG. In and Out are the input and output me­
ters, featuring an integrated volume fader to control input and output amplification.

▪ The L/R buttons [2] control the input routing. When using a guitar, deactivate the right 
channel (by clicking on R once) to route the mono signal to both stereo inputs [3].

▪ The Gate button [4] controls a basic noise gate, killing the hiss while you are not play­
ing. Turn it on and off by clicking on the button, and adjust the threshold with the 
knob. Double-click the knob to activate a learn function—do not play for some sec­
onds, and the threshold will be set automatically.

▪ Output Meter OUT [5] shows the amplitude of the software’s output and features an 
integrated volume fader that controls the output level.

▪ The Limit button [6] (de-)activates the Limiter to prevent the output level from reach­
ing harmful volume peaks.

▪ The LIVE button [7] or F1 will switch between Live View and Standard View.
▪ Clicking on the Powerbutton [8] completely bypasses the sound processing of GUITAR 

RIG, changing the CPU display to “BYP.”
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▪ The CPU load [9] represents the current load on your computer's processor and is con­
stantly measured; it should not go above 70% to avoid clicks and interruptions.

▪ If it is necessary to save some CPU power without limiting the number of compo­
nents, you can deactivate High Quality Mode by clicking on the HI button [10]. High 
Quality Mode means that the current sample rate is doubled using oversampling, re­
sulting in a higher “resolution” of the sound.

▪ GUITAR RIG Logo [1] and the The NI logo [11] opens the About Screen which dis­
plays the version number and edition of your GUITAR RIG installation.

5.1.2 Main Area
 

Beneath the Global Header there is the Main Area. It offers two different basic viewing 
modes:

▪ Standard view
▪ Live view
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Fig. 5‑2 Standard View

In Standard view, GUITAR RIG is a laboratory giving you all the options to build and or 
ganize your presets. Stack up and combine the countless effect units, prepare live gigs, 
record tracks or experiment with effect chains to shape unheard sounds.
Click the Live button, or hit F1 to switch between the Live View and the Standard View. 
The Live view hides all the sound creation tools, but puts the most important performance 
features into a clear layout—perfect for on-stage use.
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Fig. 5‑3 Live View

5.1.3 Toolbar and Rack
 

Go to Standard view by clicking the Live button again. In Standard view, the Rack is on the 
right hand side of the screen. Note the Toolbar on top of it:
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Fig. 5‑4 Toolbar

This is your one-stop-shop to access the Virtual Rig Kontrol, the Rack Tools and some han­
dy features.

▪ Click the Arrow button [1] or press F2 to reveal the Sidekick. The Sidekick displays 
different content, depending on which of the tab buttons (Browser, Components or 
Options) is activated.

▪ The currently activate preset [2] is displayed here.
▪ Use the Save and Save as buttons [3] to make changes to a preset permanent. Save will 

overwrite the existing preset. Save as creates a new preset with the current settings.
▪ Step through the current Preset List by clicking on the Up/Down arrows [4].
▪ Toggle the Virtual Rig Kontrol [5] or press F3 to show/hide it. The Virtual Rig Kontrol 

is the graphical representation of the Rig Kontrol foot controller.
▪ Click the Rack Tools to show/hide them in the rack: Tapedeck Pre [6] (for playing 

back), Tapedeck Post [7] (for recording), Tuner [8], Metronome [9] (for synchronizing 
effects and yourself), PRST [10] (Preset Volume), MSTR FX [11] (Master FX section).

▪ Click x (cross) [12] to empty the rack of all components.
▪ Clicking - (minus) [13] to minimize all rack modules. It then turns into a + (plus), al­

lowing you to restore the previous view.
The Rack itself holds all components processing your sound giving a clear overview of the 
signal flow. It is the heart of GUITAR RIG’s functionality. Go to Chapter ↑5.4, Presets to 
learn how to fill it with your content of choice!

5.1.4 Virtual Rig Kontrol
 

On bottom of the Rack, there is the Virtual Rig Kontrol. Click the Rig Kontrol icon in the 
toolbar or press F3 to show/hide it. The Virtual Rig Kontrol is the graphical representation 
of the Rig Kontrol foot controller. It conveniently shows which functions are assigned to 
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the Rig Kontrol's buttons and foot pedal. Even if you are not using the physical Rig Kon­
trol, you can assign any external controller to the Virtual Rig Kontrol to benefit from its 
graphical representation, especially in Live view. Refer to the Application Reference for 
details.

Fig. 5‑5 Virtual Rig Kontrol

5.1.5 SideKick
 

The SideKick is a multifunctional area that displays different content depending on which 
of the tab buttons (Browser, Components or Options) is activated. It is not necessary at all 
times and can be hidden by clicking the arrow button next to the tab buttons or by press­
ing F2.
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Fig. 5‑6 The SideKick in its three viewing modes

Click on Browser [1] to open the Preset Browser in the SideKick. You can organize your pre­
sets and perform a text or tag-based search to easily find your presets.
Click on Components [2] to open the Components Pool. It contains all available components 
along with their presets. You can simply drag components from here and drop them into 
the Rack. Refer to the Components Reference for detailed information on each compo­
nent.
Click on Options [3] to open the Options Menu. It serves to configure external controller as­
signments, preferences such as the window height and other details. Refer to the Applica­
tion Reference for more details.
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5.2 The Rack Tools
 

5.2.1 Tapedeck Pre and Post
 

Fig. 5‑7 Tapedeck Rack Tool

Both tapedecks basically work the same way, and very similar to the ones you may still 
know from physical racks. Yet, due to their fixed position as first (Pre) or last (Post) com­
ponent in the Rack, they are performing different functions.

▪ Tapedeck Pre is for playing back and recording audio at the beginning of Guitar Rig’s 
signal chain (except when Play at output is activated). It will pick up the dry, unpro­
cessed signal.

▪ Playback in Tapedeck Pre will send it through all modules currently in the Rack. This 
enables you to keep an unprocessed version of the signal in Tapedeck Pre.

▪ Tapedeck Post is for playing back and recording audio at the end of Guitar Rig’s sig­
nal chain. Recording your guitar will pick up the processed signal, just as you hear it 
at the output.

▪ Use Tapedeck Post if you want to record your guitar part with the actual sound, e.g. if 
you want to export a track to another program.

▪ When Sync is activated, Tapedeck Post starts and stops simultaneously with Tape­
deck Pre.

▪ To save a recorded file, just click on the save button (represented with a disk icon in 
the bottom left hand) select a name and location.
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5.2.2 Tuner
 

Fig. 5‑8 Tuner Rack Tool

The Tuner not only helps you to keep the standard tuning, but also offers some common 
tunings you can select from the dropdown menu on its left hand side.

▪ The CENT / STROBE buttons allow switching between two alternative display modes.
▪ The MUTE button is doing what it says and especially convenient when using the tuner 

live.

5.2.3 Metronome
 

Fig. 5‑9 Metronome Rack Tool

The Metronome is for keeping yourself in time, and also serves as the clock for all 
synchronized rack modules, such as modulation and delay effects.

▪ You can dial in any tempo between 20 and 400 beats per minute. Click the bpm dis­
play and drag up or down to change its value, or double-click it to enter a numerical 
value straight away.

▪ Another way to set the tempo is to click on the TAP button repeatedly. The Metronome 
will determine your average speed and set the BPM control accordingly.
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▪ You can choose different time signatures using the dropdown menu in the Signat. dis­
play.

▪ The sync setting defines if the Metronome obtains its tempo setting from any other 
source. The three available sync settings from the drop-down menu are:
– Ext: The Metronome is synchronized to an external tempo via MIDI in Standalone 

mode, or synced to the host application in Plugin mode.
– Sound: The current tempo is saved and loaded with the Rack Preset.
– Free: The Metronome can run freely at the tempo you set.

5.2.4 Preset Volume
 

Fig. 5‑10 Preset Volume Rack Tool

The sound of many of GUITAR RIG’s components is highly sensitive to the level of their 
input signal and their volume setting—just think of an amp being overdriven. This is com­
monly used for the sake of sound design, resulting in volume differences between pre­
sets.Thus, you might want to adjust the overall volume of your Rack to achieve the same 
Output Level for different presets. This is exactly what the Preset Volume does: Simply ad­
just the big volume fader after you have found the sound you were looking for—its position 
is automatically saved with your preset.

▪ Use the Learn button to automatically set the optimum Preset Volume: After clicking 
on it, just play loudly for a little while until the volume is automatically adjusted.

▪ The Pre Button allows you to control Dry / Wet mixing before audio goes thru the rack. 
In default mode mixing is done after the rack and before the Master FX.

▪ Use the Dry slider to control the volume level of the dry signal.
▪ Use the Mix crossfader to switch between the Dry signal and the Wet (effected) signal.
▪ Use the Wet slider to control the volume level of the wet signal.
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5.2.5 Master FX
 

Fig. 5‑11 Master FX Rack Tool with Twin Delay and Octaverb loaded

Whether you want to let a long delay ring over your change of presets, add a global EQ to 
all of your presets—for example when using them live—or just stick to your FX chain while 
changing amp presets: Master FX is what you need.
The Master FX extends the Rack by a section at the end, which holds components process­
ing the sound after it went through the “core” Rack. The main difference is that the con­
tent of this section remains unchanged when you load another Rack Preset, enabling vari­
ous usages as indicated above.
Using this section should feel very natural if you look at it as a Rack inside the Rack:

▪ Add components from the Components Pool or the Rack with Drag & Drop. The or­
ange line indicating the destination must be below the Master FX header.

▪ Delete, move or quickly replace components as you’re used to.
▪ Use Component Presets to configure your Master FX chain as you please.
▪ Click on the x (cross) to empty the whole Master FX section.
▪ Click on the arrow to minimize the Master FX section.
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5.3 Controlling Parameters With the Rig Kontrol
 

If you are using GUITAR RIG Kontrol, controlling GUITAR RIG with the included Rig Kon
trol foot pedal is simple. For details on controller assignments and how to use other con­
trollers, please consult the Application Reference. Make sure that your Rig Kontrol is con­
nected via USB 2.0 and activate the Virtual Rig Kontrol by clicking the CONNECT button in 
the Rig Kontrol Toolbar.

▪ On the Virtual Rig Kontrol, each button is headed with an LED indicating its status 
(on/off). The LED bar left of the foot pedal shows the degree to which it is pressed 
down. The buttons, as well as the foot pedal, can also be operated with the mouse.

▪ The labels below the buttons and left of the foot pedal precisely show which function 
is currently assigned to them. You can drag and drop them to various controls to as­
sign functions such as play or record to them.

▪ The buttons of the Rig Kontrol are best suited for controlling On/Off switches of rack 
modules and the likes, whereas the pedal is perfect for continuous parameters like 
the wah-wah slider or volume.

5.4 Presets
 

The tag-based Preset Browser and a powerful search function make navigating and manag­
ing presets easy. Component Presets allow for a modular approach to preset building.
At this point, it is important to understand the two different kinds of presets in GUI­
TAR RIG:

Rack Presets
Rack Presets allow you to store and recall complete Rack setups and organize them in a 
convenient way. Each Rack Preset consists of a chain of components with their exact. 
GUITAR RIG ships with a huge amount of Rack Presets of any style, and you can easily
create your own ones.
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Component Presets
A Component Preset contains all settings for one single component, e.g. the knob posi­
tions of an amp. After highlighting one of the items in the Components Pool, all its availa­
ble presets are shown in a list below.

5.4.1 The Preset Browser
 

In the SideKick, click on the Browser button to open the Preset Browser.

Fig. 5‑12 Preset Browser
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▪ Three columns with Preset Attributes (also referred to as tags) define which presets 
are shown in the Preset List below.

▪ If no tag is highlighted (orange), all available presets are shown.
▪ A text-based search bar sits on top of the Preset List, providing a quick way to find a 

particular preset in the current list by name.
▪ You can sort the Preset List by List Number, Name and Rating.
▪ The Rating is very helpful for keeping order in your growing archive: Give each preset 

a quality rating by clicking on one of the 5 dots in the line of its name.
▪ The buttons on the bottom of the SideKick allow for saving presets, and for switching 

to the Info page of a preset.

Saving Rack Presets
▪ Pressing the Save button will make any changes to the currently loaded preset perma­

nent.
▪ Pressing the Save As… button will open the Save Page to create a new preset. It will 

automatically be tagged with the currently highlighted Preset Attributes.
▪ You can still change these, as well as entering additional information for the preset, 

before confirming by clicking on Save.

Using Tags on Three Levels
The tags in the Preset Attributes list are hierarchic, detailing a category or description 
from left to right. This is useful when searching for presets. Each tag of the first and sec­
ond level can contain sub-tags that allow you to further narrow down what you are looking 
for. For example, the tag “Guitar Styles” (1st column) could contain a “Rock” tag (2nd 
column). The tag “Rock” could contain “80s Punk Heros” (3rd column)—among others.
You can create and relate tags to bring your presets into the structure that fits your needs 
best. As each preset can appear under multiple tags of different levels, you have a lot of 
organizational power at hand.

5.4.2 How to Create Tags
 

Let us create an exemplary three-level tag for presets you want to use on stage with your 
band. The levels could read something like this: “My Presets – The Band – Live”:
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▪ Create a new tag. Right-click in the first column, select Create a new tag (or simply 
double-click on an empty field). Type in a text label (“My Presets”) and press Enter.

▪ Click on the newly created tag to select it—it must be highlighted. Double-click into 
the middle column and create a new tag (“The Band”). This is your first sub-tag.

▪ Creating a sub-tag on the third level works exactly the same way, just highlight “The 
Band” and create a new tag called “Live” in the right-most column.

Fig. 5‑13 Preset Attributes

Tagging Presets
Adding tags to presets works with drag and drop: Just click on one of the presets in the 
Preset list and drag it onto one of the tags in the left column of the Preset Browser.
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Fig. 5‑14 Tagging Presets

The preset will now be listed both under the tag that was activated before you dragged it, 
and under the new tag. To delete a tag, just delete the preset from the according list—no 
worries, the preset itself is not deleted by this action!

5.4.3 Using Component Presets
 

GUITAR RIG comes with plenty of factory presets for components. They are a time-saving 
alternative to adjusting sound manually for each component. After selecting an item of the 
Component Pool, a list of all available Component Presets is displayed in the lower part of 
the SideKick.
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Fig. 5‑15 Using Component Presets

Double-clicking the Component Preset in the list has the same effect as double-clicking 
the basic component in the Component Browser:

▪ If no rack module is highlighted, the component will be added to the end of the rack 
with the stored settings.

▪ If a different component is highlighted, it will be replaced with the new, adjusted 
component.

▪ If the same component is highlighted in the rack, its settings will be updated with the 
component preset. This is useful if you quickly want to check out different settings of 
a component in the context of your current rack.

▪ You can even drag and drop a Component Preset anywhere into the Rack!
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Fig. 5‑16 Saving Presets

Once you have found a “perfect setting” for components you use regularly, you can save 
your own Component Preset. Click on the triangular arrow right of the Component Preset 
Display (left on each rack module) and select Save As. This will create a new entry in the 
according list of Component Presets. Type in a name and press Enter.
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6 What’s Next?
 

Congratulations, you now know about the most important functions of GUITAR RIG. For   
further steps in exploring the software, we recommend both reference manuals, depending 
on your individual learning goal:

▪ The Application Reference deepens the aspects touched in this short introduction and 
should leave no question unanswered. It is the place to go if you want to learn how to 
control the software via MIDI (section 8.1), how to fully exploit the Preset Browser 
(section 3.1), but also how to realize overdub recordings using the Tapedecks (section 
5), and much more!

▪ The Components Reference introduces all of GUITAR RIG’S components, explaining all
their parameters and the way they treat the sound. This is your next stop if you want 
to quickly build your own Racks, exactly understanding what each module can do for 
you.

Regardless where you go from here, have fun and success using GUITAR RIG—make it       
your tool for perfect custom tone.
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